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Preface

This guide describes how to install, configure and use VERITAS NetBackup for Informix 
on a UNIX platform. In this guide, VERITAS NetBackup for Informix is referred to as 
NetBackup for Informix. 

For specific information about the NetBackup server software, refer to: 

◆	 NetBackup System Administrator’s Guide for UNIX, Volumes I and II, if you have a UNIX 
server. 

or 

◆	 NetBackup System Adminstrator’s Guide for Windows, Volumes I and II, if you have a 
Windows server. 

This document is the same as NetBackup_AdminGuide_Informix.pdf distributed 
with the NetBackup for Informix software. 
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Audience 
Audience 
This guide is intended for the: 

◆	 Informix database system administrator responsible for configuring and using the 
Informix On-BAR Utility to back up and restore Informix databases. 

◆ NetBackup system administrator responsible for configuring NetBackup. 

A system administrator is defined as a person with system administrator privileges and 
responsibilities. 

This guide assumes: 

◆ A basic understanding of system administration. 

◆ A working understanding of the NetBackup client and server software. 

◆ A familiarity with the information covered in the following NetBackup manuals: 

◆ Backup, Archive, and Restore Getting Started Guide for UNIX and Windows 

◆	 NetBackup System Administrator’s Guide for UNIX, Volumes I and II or NetBackup 
System Adminstrator’s Guide for Windows, Volumes I and II 

◆ NetBackup Troubleshooting Guide for UNIX and Windows 

◆ A thorough understanding of the following Informix database topics: 

◆ Database file types and their relationships at recovery time 

◆ Data recovery scenarios 

◆ Informix On-BAR Utility 

What Is In This Guide? 
This guide is organized as follows: 

◆ Introduction is an overview of the product’s capabilities. 

◆	 The Installation chapter explains how to install NetBackup for Informix on your 
system. 

◆	 Configuration explains how to configure your system to use NetBackup for Informix. 
This information supplements the NetBackup and Informix manuals. 

◆	 Using NetBackup for Informix explains how to use this product to back up and 
restore your Informix databases. This information supplements the NetBackup 
manuals. 

◆	 The Troubleshooting chapter contains instructions on troubleshooting NetBackup for 
Informix. 
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Getting Help 
Getting Help 
VERITAS offers you a variety of support options. 

Accessing the VERITAS Technical Support Web Site 

The VERITAS Support Web site allows you to: 

◆	 obtain updated information about NetBackup for Informix, including system 
requirements, supported platforms, and supported peripherals 

◆ contact the VERITAS Technical Support staff and post questions to them 

◆ get the latest patches, upgrades, and utilities 

◆ view the NetBackup for Informix Frequently Asked Questions (FAQ) page 

◆ search the knowledge base for answers to technical support questions 

◆ receive automatic notice of product updates 

◆ find out about NetBackup for Informix training 

◆ read current white papers related to NetBackup for Informix 

The address for the VERITAS Technical Support Web site follows: 

◆ http://support.veritas.com 

Subscribing to VERITAS Email Notification Service 

Subscribe to the VERITAS Email notification service to be informed of software alerts, 
newly published documentation, Beta programs, and other services. 

Go to http://support.veritas.com. Select a product and click “E-mail Notifications” on the 
right side of the page. Your customer profile ensures you receive the latest VERITAS 
technical information pertaining to your specific interests. 

Accessing VERITAS Telephone Support 

Telephone support for NetBackup for Informix is only available with a valid support 
contract. To contact VERITAS for technical support, dial the appropriate phone number 
listed on the Technical Support Guide included in the product box and have your product 
license information ready for quick navigation to the proper support group. 
Chapter , ix 



NetBackup for Informix Manuals 
▼ To locate the telephone support directory on the VERITAS web site 

1. Open http://support.veritas.com in your web browser. 

2.	 Click the Phone Support icon. A page that contains VERITAS support numbers from 
around the world appears. 

Accessing VERITAS E-mail Support 

▼ To contact support using E-mail on the VERITAS web site 

1. Open http://support.veritas.com in your web browser. 

2.	 Click the E-mail Support icon. A brief electronic form will appear and prompt you to: 

◆ Select a language of your preference 

◆ Select a product and a platform 

◆ Associate your message to an existing technical support case 

◆ Provide additional contact and product information, and your message 

3. Click Send Message. 

Contacting VERITAS Licensing 

For license information call 1-800-634-4747 option 3, fax 1-650-527-0952, or e-mail 
amercustomercare@veritas.com. 

NetBackup for Informix Manuals 
The following manuals, along with the online help, are included in the NetBackup for 
Informix documentation set. For a more detailed listing of NetBackup documents, refer to 
NetBackup Release Notes for UNIX and Windows. 

If you have a UNIX server, refer to these documents: 

◆ VERITAS NetBackup System Administrator's Guide for UNIX, Volume I 

NetBackup_AdminGuideI_UNIXServer.pdf 

Explains how to configure and manage NetBackup on a UNIX server, including 
managing storage units, backup policies, catalogs and host properties. 

◆ VERITAS NetBackup System Administrator's Guide for UNIX, Volume II 
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Informix Manuals 
NetBackup_AdminGuideII_UNIXServer.pdf 

Explains additional NetBackup features such as notify scripts, enhanced 
authorization and authentication, and role-based security. The guide also discusses 
using NetBackup with AFS, Intelligent Disaster Recovery (IDR), and the BE Tape 
Reader. 

◆ NetBackup Media Manager System Administrator’s Guide for UNIX 

Explains how to configure and manage the storage devices and media on UNIX 
NetBackup servers. Media Manager is part of NetBackup. 

◆ VERITAS NetBackup Troubleshooting Guide for UNIX and Windows 

Provides troubleshooting information for UNIX- and Windows-based NetBackup 
products, including Media Manager. 

If you have a Windows server, refer to these documents: 

◆ VERITAS NetBackup System Administrator’s Guide for Windows, Volume I 

NetBackup_AdminGuideI_WinServer.pdf 

Explains how to configure and manage NetBackup on a Windows server, including 
managing storage units, backup policies, catalogs and host properties. 

◆ VERITAS NetBackup System Administrator’s Guide for Windows, Volume II 

NetBackup_AdminGuideII_WinServer.pdf 

Explains additional NetBackup features such as notify scripts, enhanced 
authorization and authentication, and role-based security. The guide also discusses 
using NetBackup with AFS, Intelligent Disaster Recovery (IDR), and the BE Tape 
Reader. 

◆ NetBackup Media Manager System Administrator’s Guide for Windows 

Explains how to configure and manage the storage devices and media on Windows 
NetBackup servers. Media Manager is part of NetBackup. 

◆ VERITAS NetBackup Troubleshooting Guide for UNIX and Windows 

Provides troubleshooting information for UNIX- and Windows-based NetBackup 
products, including Media Manager. 

Informix Manuals 
For this product, you may need the IBM Informix Backup and Restore Guide from Informix. 
Check the IBM website for the correct version of the backup and restore guide for your 
Informix environment. 
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Glossary 
Glossary 
If you encounter unfamiliar terminology, consult the NetBackup online glossary. The 
glossary contains terms and definitions for NetBackup and all additional NetBackup 
options and agents. 

The NetBackup online glossary is included in the NetBackup help file. 

▼ To access the NetBackup online glossary 

1. In the NetBackup Administration Console, click Help > Help Topics.


2. Click the Contents tab.


3. Click Glossary of NetBackup Terms.


Use the scroll function to navigate through the glossary.


Accessibility Features 
NetBackup contains features that make the user interface easier to use by people who are 
visually impaired and by people who have limited dexterity. Accessibility features 
include: 

◆	 Support for assistive technologies such as screen readers and voice input (Windows 
servers only) 

◆	 Support for keyboard (mouseless) navigation using accelerator keys and mnemonic 
keys 

For more information, see the NetBackup System Administrator’s Guide for Windows, 
Volume I or the NetBackup System Administrator’s Guide for UNIX, Volume I. 
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Conventions 
The following conventions apply throughout the documentation set. 

Product-Specific Conventions 

The following term is used in the NetBackup for Informix 5.1 documentation to increase 
readability while maintaining technical accuracy. 

◆ Microsoft Windows, Windows 

Terms used to describe a specific product or operating system developed by 
Microsoft, Inc. Some examples you may encounter in NetBackup documentation are, 
Windows servers, Windows 2000, Windows Server 2003, Windows clients, Windows 
platforms, or Windows GUI. 

When Windows or Windows servers is used in the documentation, it refers to all of 
the currently supported Windows operating systems. When a specific Windows 
product is identified in the documentation, only that particular product is valid in that 
instance. 

For a complete list of Windows operating systems and platforms that NetBackup 
supports, refer to the NetBackup Release Notes for UNIX and Windows or go to the 
VERITAS support web site at http://www.support.veritas.com. 

Typographical Conventions 

Here are the typographical conventions used throughout the manuals: 

Conventions 

Convention Description 

GUI Font	 Used to depict graphical user interface (GUI) objects, such as fields, 
listboxes, menu commands, and so on. For example: Enter your 
password in the Password field. 

Italics	 Used for placeholder text, book titles, new terms, or emphasis. Replace 
placeholder text with your specific text. For example: Replace filename 
with the name of your file. Do not use file names that contain spaces. 

This font is also used to highlight NetBackup server-specific or operating 
system-specific differences. For example: This step is only applicable for 
NetBackup Enterprise Server. 

Code	 Used to show what commands you need to type, to identify pathnames 
where files are located, and to distinguish system or application text that 
is displayed to you or that is part of a code example. 
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Conventions  (continued) 

Convention Description 

Key+Key	 Used to show that you must hold down the first key while pressing the 
second key. For example: Ctrl+S means hold down the Ctrl key while 
you press S. 

You should use the appropriate conventions for your platform. For example, when 
specifying a path, use backslashes on Microsoft Windows and slashes on UNIX. 
Significant differences between the platforms are noted in the text. 

Tips, notes, and cautions are used to emphasize information. The following samples 
describe when each is used. 

Tip Used for nice-to-know information, like a shortcut. 

Note	 Used for important information that you should know, but that shouldn’t cause any 
damage to your data or your system if you choose to ignore it. 

Caution	 Used for information that will prevent a problem. Ignore a caution at your own 
risk. 

Command Usage 

The following conventions are frequently used in the synopsis of command usage. 

brackets [ ] 

The enclosed command line component is optional. 

Vertical bar or pipe (|) 

Separates optional arguments from which the user can choose. For example, when a 
command has the following format: 

command arg1|arg2


In this example, the user can use either the arg1 or arg2 variable. 

Navigating Multiple Menu Levels 

When navigating multiple menu levels, a greater-than sign (>) is used to indicate a 
continued action. 

The following example shows how the > is used to condense a series of menu selections 
into one step: 
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❖	 Select Start > Programs > VERITAS NetBackup > NetBackup Administration 
Console. 

The corresponding actions could be described in more steps as follows: 

1. Click Start in the task bar. 

2. Move your cursor to Programs. 

3. Move your cursor to the right and highlight VERITAS NetBackup. 

4.	 Move your cursor to the right. First highlight and then click NetBackup 
Administration Console. 
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1


NetBackup for Informix integrates the database backup and recovery capabilities of 
Informix On-BAR Utility with the backup and recovery management capabilities of 
NetBackup and its Media Manager. 

This chapter introduces NetBackup for Informix and how it relates to both Informix 
On-BAR Utility and NetBackup. Read this chapter for a description of: 

◆ Features of NetBackup for Informix 

◆ Terminology for NetBackup for Informix 

◆ Technical Overview of NetBackup for Informix 
1 
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Features of NetBackup for Informix 
This section describes the NetBackup for Informix main features. 

NetBackup for Informix main features 

Feature Description 

Media and device 
management 

Scheduling facilities 

Multiplexed backups and 
restores 

Transparent execution of 
both Informix and 
regular file system 
backup and restore 
operations 

Sharing the same devices 
and tapes used during 
other file backups 

Centralized and 
networked backup 
operations 

All devices supported by Media Manager are available to 
NetBackup for Informix. 

NetBackup scheduling facilities on the master server can be 
used to schedule automatic and unattended Informix 
backups. 

This also lets you choose the times when these operations can 
occur. For example, to prevent interference with normal 
daytime operations, you can schedule your database backups 
to occur only at night. 

NetBackup for Informix lets you take advantage of 
NetBackup’s multiplexing capabilities. Multiplexing directs 
multiple data streams to one backup device, thereby reducing 
the time necessary to complete the operation. 

All backups and restores are run simultaneously and 
transparently without any action from the NetBackup 
administrator. 

An Informix administrator can run database backup and 
restore operations through NetBackup or use Informix 
On-BAR Utility as if NetBackup were not present. 

An administrator or any other authorized user can use 
NetBackup to run database backups and restores. 

It is possible to share the same devices and media used for 
other backups or to give Informix exclusive use of certain 
devices and media. 

From the NetBackup master server, you can schedule 
database backups or start them manually for any client. The 
Informix databases can also reside on hosts that are different 
from the devices on which NetBackup stores the backups. 
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NetBackup for Informix main features 

Feature Description 

Graphical user interfaces	 NetBackup provides the following graphical user interfaces 
for client users and administrators: 

◆ Backup, Archive, and Restore user interface 

◆ Client user motif interface, xbp 

◆ NetBackup Administration Console for Java 

◆ NetBackup Administration Console for Windows 

A database administrator or NetBackup administrator can 
start backup or restore operations for Informix from the 
NetBackup graphical user interface on the master server. 

Parallel backup and NetBackup for Informix supports the parallel backup and 
restore operations	 restore capabilities of the Informix On-BAR Utility. This 

permits the user to run more than one tape device at a time for 
a single Informix backup or restore, thereby reducing the time 
necessary to complete the operation. 
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Terminology for NetBackup for Informix 
This section explains important terms that may be new to an Informix database 
administrator or a NetBackup administrator. 

NetBackup Terms 
This section describes NetBackup terms as they apply to NetBackup for Informix. 

NetBackup 

NetBackup policy 

NetBackup schedule 

Administrator-directed 
backups 

User-directed backups and 
restores 

Graphical interfaces 

Media Manager 

NetBackup backs up and restores files, directories, raw partitions, and 
databases on client systems that have Informix databases. 

NetBackup policies define criteria for backups and restores. These 
criteria include storage unit and media to use, backup schedules, 
clients, files to back up, or backup templates or scripts to execute. 

NetBackup schedules control NetBackup operations such as: when 
backups can occur, the type of backup (full, incremental) to perform, 
and how long NetBackup retains the image (retention level). 

NetBackup administrators are able to perform remote backups of all 
files, directories, databases, and raw partitions contained on client 
systems within a client/server network via NetBackup interfaces. 

NetBackup users are able to perform backups of all files, directories, 
databases, and raw partitions contained on client systems within a 
client system. 

Graphical user interfaces are available for both users and 
administrators. 

The Media Manager provides complete management and tracking of 
all devices and media used during backups and restores. 

For explanations of other NetBackup terms, consult the NetBackup online glossary. For 
instructions, see the “Glossary” section in the Preface. 
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NetBackup for Informix Terms 

Informix On-BAR The Informix On-BAR Utility allows database administrators to 
Utility	 back up and restore Informix databases on UNIX systems. This 

utility, however, does not directly manage storage devices and 
media. The Informix On-BAR Utility must be integrated with a 
media management system that can access devices and keep 
information about the media used in Informix database 
backups. NetBackup for Informix provides this 
media-management capability by integrating the utility with 
NetBackup. 

onbar	 The onbar command starts a backup or restore with the 
Informix On-BAR Utility. This command is described in the 
Informix Backup and Restore Guide. 

On-BAR scripts A Bourne-shell script that contains onbar commands. 

Onsmsync	 Onsmsync is an Informix version XPS 8.x, IDS 9.x, and later 
feature which synchronizes the NetBackup catalog with the 
Informix backup catalog. The onsmsync utility feature is used to 
delete images from both Informix backup catalogs and 
NetBackup catalogs. Refer to the Informix Server Administration 
Guide for more information on how to use this utility. 
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Technical Overview of NetBackup for Informix 
The example network below shows the major components in a NetBackup for Informix 
configuration. 

The storage devices are connected to the NetBackup master server. The host with the 
database must be a NetBackup client and have NetBackup for Informix and the Informix 
On-BAR Utility software installed. 

System containing Informix database 

NetBackup master server 
or remote media server 

Informix database software supplies: 

– Informix On-BAR Utility 

onbar 

Network (TCP/IP) 

NetBackup for Informix supplies: 

– Vendor I/O Library 
– Sample configuration program 
– Sample script files 

NetBackup software: 

– NetBackup Master Server 

Additional required NetBackup software: 

– NetBackup Master Server 
– NetBackup Client 

Tape or optical 
storage device 

Informix 
database to back 
up up or restore 

– NetBackup Media Server 
(if system is a media server) 

Informix On-BAR Utility 
During a backup or restore, the Informix On-BAR Utility provides the interface to the 
databases and performs the actual extraction and insertion of data. 

To start a database backup or restore, the database administrator must execute a 
command called onbar. This command is part of the Informix On-BAR Utility and can be 
executed from the command line, an On-BAR script, or an application such as NetBackup. 
An On-BAR script includes the onbar command to be executed and defines the database 
objects to be backed up or restored. 
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During a backup or restore, the Informix On-BAR Utility controls the data streams going 
into or out of a database. In order to access the storage devices, this utility must be 
integrated with a media-management system such as the one provided by NetBackup and 
its Media Manager. 

The onbar command is documented in the Informix Backup and Restore Guide. 

For instructions on finding the Informix version level supported, refer to “Installation” on 
page 9. 

NetBackup for Informix 
NetBackup for Informix has a special library that contains the functions necessary for the 
Informix On-BAR Utility to use NetBackup. 

Sequence of Operation 
An On-BAR script can be executed from either the NetBackup scheduler or manually 
from the NetBackup administration interface on the NetBackup master server, from the 
NetBackup Backup, Archive, and Restore interface or from the command line on the 
NetBackup client. With the exception of the command line method, a NetBackup process 
named bphdb starts the On-BAR script on the client. 

For a backup: 

1. The onbar command starts the requested operation on the databases. 

2.	 When the process requires media to store backup data, onbar starts a user-directed 
backup by issuing a backup request. 

3.	 The NetBackup master server connects to On-BAR through the NetBackup library on 
the client and transfers the database data to secondary storage. 

For a restore: 

A restore works in essentially the same manner except that onbar issues a restore request. 
This causes NetBackup to retrieve the data from secondary storage and send it to 
NetBackup for Informix on the client. 

The status for an On-BAR operation is logged in the Informix BAR_ACT_LOG. A 
database administrator can use this log to determine if a backup or restore was successful. 

NetBackup also logs status, but only for its own part of the operation. The database 
administrator cannot use NetBackup status to determine whether On-BAR was successful 
because errors can occur in On-BAR that do not affect NetBackup and are not recorded in 
its logs. 
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Installation 
2


This chapter describes the NetBackup for Informix installation and setup procedures. It 
includes a section on installation prerequisites. 

▼ To locate the latest Database Agent information on the VERITAS support web site 

1. Go to the VERITAS support web page: http://www.support.veritas.com. 

2.	 From the Select Product Family list, choose NetBackup Products. The Select Product 
window refreshes showing a list of NetBackup products. 

3.	 Select one of the NetBackup products. The page refreshes and displays a search 
window with four tabs. 

4. Select 5.1 in the Product Version drop-down field. 

5. Select a Product Platform. 

6.	 Click the Compatibility tab. The page refreshes showing documents that contain 
compatibility information. 

7.	 Click on the title of the document link for NetBackup Database Agent Compatibility 
List. A document appears that contains a downloadable file that enables you to view 
the supported database spreadsheet for this release. 
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Installation Prerequisites 
Before installing NetBackup for Informix, be sure you have completed the following 
procedures: 

❖	 Install the Informix vendor software on the client where you will be backing up the 
databases. 

See the Informix-Online Dynamic Server Administration Guide. 

❖ Install the NetBackup server software on the server. 

The NetBackup server platform can be any of those that NetBackup supports. 

Refer to the NetBackup Installation Guide for UNIX or the NetBackup Installation Guide 
for Windows. 

❖	 Install the NetBackup client software on the machine where the Informix vendor 
software resides. 

Refer to the NetBackup Installation Guide for UNIX for installation instructions. 

Now you are ready to install NetBackup for Informix on the client where you will be 
backing up the databases. Refer to the next section for detailed instructions on installing 
NetBackup for Informix. 

Guidelines for Installing NetBackup for Informix in a Cluster 
◆	 Prior to installing NetBackup for Informix, the NetBackup server must be installed 

and configured to work in a cluster. (This is accomplished by following the 
instructions in the NetBackup Installation Guide for UNIX, including running the 
cluster_config script after the NetBackup server software has been installed.) 

◆	 Commands such as bpplclients and update_dbclients must be run from the 
active NetBackup node. If you are pushing the database agent software to clients 
located in a cluster, specify the individual node names (not virtual names) in the list of 
clients. 

◆	 If installing NetBackup for Informix on a clustered NetBackup server, freeze the active 
NetBackup node before beginning the installation. Install on all the inactive nodes, 
then install on the active node. After you successfully install on the active node, 
unfreeze this node. 

◆	 The cluster_config script only needs to be run after the NetBackup server 
software has been installed. You do not need to run this script after installing 
NetBackup for Informix on a NetBackup server or if you wish to install NetBackup for 
Informix on a machine on which only the NetBackup client is installed. 
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Installing NetBackup for Informix 
There are two ways to install database agent software. 

◆	 Remote installation: Loads the software on a master server. The user then pushes the 
database software out to affected clients. 

Refer to the following section. 

◆ Local installation: Loads and installs the software only to the local machine. 

Refer to “Local Installation of NetBackup for Informix” on page 16. 

Remote Installation of NetBackup for Informix 
During a remote installation, NetBackup for Informix files are loaded onto the current 
machine, which must be a UNIX master server. The software is then distributed to the 
clients and installed. 

Note	 In a clustered environment, the capability to push client software is only available 
from the active node. 

Installation Requirements 

◆	 The version of the NetBackup client and the version of NetBackup for Informix must 
be the same (for example, 5.1). 

◆ There must be adequate disk space on each client that will receive the software. 

Less than one megabyte of additional disk space is required in the client’s 
install_path/netbackup directory. However, more disk space may be necessary 
at run time. 

◆ NetBackup version 5.1 software is installed and operational on each Informix client. 

This also means that the directory install_path/netbackup already exists on 
each Informix client. 

◆	 In a clustered environment, NetBackup server software has been installed and 
configured to work in a cluster. (This is accomplished by following the instructions in 
the NetBackup Installation Guide for UNIX, including running the cluster_config 
script after the NetBackup server software is installed.) 
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Remote Installation Instructions 

▼ To perform a remote installation 

1.	 If installing NetBackup for Informix on a clustered NetBackup server, first refer to the 
“Guidelines for Installing NetBackup for Informix in a Cluster” earlier in this chapter. 

2.	 Log in as the root user on the server. 

If you are already logged in, but are not the root user, run the following command. 

su - root


3.	 Make sure a valid license key for NetBackup for Informix has been registered. To view 
or add license keys, perform one of the following: 

◆ Run the following command: 

install_path/netbackup/bin/admincmd/get_license_key. 

◆ Open the NetBackup Administration Console and choose Help > License Keys. 

4. Insert the CD-ROM into the drive. 

5.	 Change the working directory to the CD-ROM directory. 

cd /CD_mount_point 

6.	 Load the software on the server by executing the install script. 

./install 

a.	 Select the NetBackup Database Agent Software option. 

The following prompt appears: 

Do you want to do a local installation? (y/n) [n]


b.	 Answer n. 

You are presented with a menu of all database agents available on the CD-ROM. 

c. Select the NetBackup for Informix option. 

d.	 Enter q to quit selecting options. 

A prompt appears asking if the list is correct. 

e. Answer y. 
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The install script identifies the types of client software loaded during the 
installation of the NetBackup server. By default, any matching NetBackup for 
Informix software is automatically loaded. If there are more platforms available, 
the script displays a menu giving you the opportunity to add more client types to 
the default list. Once the list is complete, database agent version files, compressed 
tar files and the install_dbext script are copied to directory 
install_path/netbackup/dbext. 

7.	 Distribute and install the NetBackup for Informix software on each client as described 
in the next sections. 

Note	 In a clustered environment, the capability to distribute client software is only 
available from the active node. 

There are two types of installation processes. 

◆	 initial install: Use an initial install if the clients you intend to update have not been 
added to policies of type Informix-On-BAR. 

◆	 upgrade install: Use an upgrade install if all the clients you intend to update 
already have been added to policies of type Informix-On-BAR. 

Note	 The NetBackup version level (for example, 5.1) running on the clients you wish to 
update must be the same as the version level of the NetBackup for Informix being 
installed. 

Initial Installation on Clients 

▼ To perform an initial install on the clients 

1.	 Run the following command to create a file containing a list of clients currently 
configured in the NetBackup database. 

cd install_path/netbackup/bin

./admincmd/bpplclients -allunique -noheader > filename


where filename is the name of the file to contain the list of unique clients. If no 
clients have been configured in the NetBackup database, and therefore filename is 
empty, create filename using the same format as that generated by bpplclients. 

bpplclients generates output in following format: 

hardware operating_system client_name 
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where: 

hardware is the hardware name. For example, execute the ls command in 
directory install_path/netbackup/client. 

operating_system is the operating system name. For example, execute the ls 
command in directory install_path/netbackup/client/hardware. 

client_name is the name of the client. 

For example, the contents of filename might look like this: 

Solaris Solaris8 curry

RS6000 AIX4.3.3 cypress


2. Edit filename. 

This is an optional step. Use it if the contents of filename need to be changed. Edit 
filename to contain only those clients you wish to update with NetBackup for Informix 
software. 

3. Specify filename in the update_dbclients command. 

For example: 

cd install_path/netbackup/bin 
./update_dbclients Informix -ClientList filename 

Only clients listed in filename are updated. 

Note	 If the receiving client is configured as an HP-UX11.00, HP-UX11.11, Solaris7, 
Solaris8, Solaris9, AIX4.3.3, or AIX5 machine, both the 32-bit and 64-bit versions of 
NetBackup for Informix will be installed. 

Note	 With an initial or upgrade install, some clients may be skipped and not updated. 
Possible reasons are: 
- the client is a PC client (which cannot be updated from a UNIX server) 
- NetBackup for Informix does not support that client's platform type 

- the NetBackup for Informix software for that client type was not loaded onto the 

server in step 6 of the “Remote Installation Instructions” on page 12

- (if using the ALL ALL method) the client does not belong to the Informix-On-BAR

policy type 

All skipped clients are available in a file whose name is displayed by

update_dbclients.
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Upgrade Installation on Clients 

▼ To perform an upgrade installation on the clients 

1. Execute the following command. 

cd install_path/netbackup/bin

./update_dbclients Informix ALL ALL


This command looks at all possible clients and updates only the clients currently in 
the Informix-On-BAR policy type. 

Instead of ALL ALL, you may use -ClientList filename as explained in “Initial 
Installation on Clients” on page 13. 

Note	 If the receiving client is configured as an HP-UX11.00, HP-UX11.11, Solaris7, 
Solaris8, Solaris9, AIX4.3.3, or AIX5 machine, both the 32-bit and 64-bit versions of 
NetBackup for Informix will be installed. 

Note	 With an initial or upgrade install, some clients may be skipped and not updated. 
Possible reasons are: 
- the client is a PC client (which cannot be updated from a UNIX server) 
- NetBackup for Informix does not support that client's platform type 

- the NetBackup for Informix software for that client type was not loaded onto the 

server in step 6 of the “Remote Installation Instructions” on page 12

- (if using the ALL ALL method) the client does not belong to the Informix-On-BAR 

policy type 

All skipped clients are available in a file whose name is displayed by

update_dbclients.


The number of updates required to distribute the software to the clients is displayed. 

If more than one update will occur, you will see the following prompt: 

Enter the number of simultaneous updates you wish to take place. 1 - max dflt 

(must be in the range of 1 to max; default: dflt). 

where: 

max is the maximum number of simultaneous updates that is allowed. The value 
displayed ranges from 1 to 30. 

dflt is the default number the program uses if you press Enter. The value 
displayed ranges from 1 to 15. 

For example, if three client updates will be performed, the max and dflt values shown 
would be 3. If 50 client updates will be performed, the max value shown would be 30 
and the dflt value shown would be 15. 
Chapter 2, Installation 15 



Installing NetBackup for Informix 
update_dbclients starts the number of updates that you specify. If this number is 
less than the total number of client updates to be performed, new updates start as the 
previous updates finish until all of the updates have been completed. 

Based on your answer, the time it will take to update the clients is displayed, followed 
by this question: 

Do you want to upgrade the clients now? (y/n) [y]


2. Enter y or n for the prompt. 

If you answer n, update_dbclients quits and leaves the list of clients it would 
have updated in a file. This file can later be used by the -ClientList parameter 
mentioned previously. 

Answer y to continue the installation process. 

If the update_dbclients command was successful in distributing the software to the 
client, it automatically runs the install_dbext script on the client. If install_dbext 
has successfully completed, there will be a version file in directory 
install_path/share that contains the version of NetBackup for Informix that was 
installed. The update_dbclients command displays a note on whether the update was 
successful for each client. When the update_dbclients command has completed, it 
displays a file name that contains a complete log of what happened for each client. If the 
update failed for any client, the log file should be examined to determine the problem. 

Local Installation of NetBackup for Informix 
During a local installation, the NetBackup for Informix files are extracted and installed. 
The local machine can be a client or a master server that also happens to be a client. 

Installation Requirements 

◆	 The version of the NetBackup client and the version of NetBackup for Informix are 
the same (for example, 5.1). 

◆ The local machine must have adequate disk space. 

Less than one megabyte of additional disk space is required in the 
install_path/netbackup directory. However, more disk space may be necessary 
at run time. 

◆ NetBackup version 5.1 client software is installed and operational. 

This also means that the install_path/netbackup directory already exists. 
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Local Install Instructions 

▼	 To install NetBackup for Informix to the local machine 

1. Log in as the root user on the machine. 

If you are already logged in, but are not the root user, run the following command. 

su - root


◆ If the local machine is a client, go to step 3.


◆ If the local machine is a server, go to step 2.


2.	 Make sure a valid license key for NetBackup for Informix has been registered. In a 
NetBackup server clustered environment, the license key must be registered on each 
node. To view or add license keys, perform one of the following: 

◆	 Run the command 
install_path/netbackup/bin/admincmd/get_license_key. 

◆ Open the NetBackup Administration Console and choose Help > License Keys. 

3. Insert the CD-ROM into the drive. 

4.	 Change the working directory to the CD-ROM directory. 

cd /CD_mount_point 

5. Load and install the software by executing the install script. 

Note	 It is expected that the NetBackup version level (for example, 5.1) running on the 
local machine matches the version level of the database agent being installed. 

./install


a.	 Select the NetBackup Database Agent Software option. 

The following prompt appears: 

Do you want to do a local installation? (y/n) [n]


b.	 Answer y. 

You are presented with a menu of all database agents available on the CD-ROM. 

c. Select the NetBackup for Informix option. 

d. Enter q to quit selecting options. 
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A prompt appears asking if the list is correct. 

e. Answer y. 

The following actions occur: 

◆	 The version file, compressed tar file and install_dbext script are loaded to 
directory install_path/netbackup/dbext. 

◆ The install script automatically executes the install_dbext script. 

◆	 If the receiving client is configured as an HP-UX11.00, HP-UX11.11, Solaris7, 
Solaris8, Solaris9, AIX4.3.3, or AIX5 machine, both the 32-bit and 64-bit 
versions of NetBackup for Informix will be installed. 

◆	 If install_dbext has successfully completed, there will be a version file in 
directory install_path/share that contains the version of NetBackup for 
Informix that was installed and an installation timestamp. 

f. Enter q to quit from the script. 

Specifying the Informix Home Path 
After you install NetBackup for Informix, you will need to perform an additional setup 
step that provides NetBackup for Informix with information about your Informix 
environment. NetBackup for Informix provides a script to accomplish this setup. 

▼ To specify the Informix home path 

1.	 Change to the following directory: 

/usr/openv/netbackup/bin 

2.	 Run the setup command: 

./informix_config 

The following appears: 

Please specify the Informix instance home path name:


3.	 Supply the appropriate name for the Informix instance home path. 

The command finishes and the setup step is complete. 

4. Verify the Informix On-BAR Utility configuration. 
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This script creates the following entry in the Informix instance home path’s 
etc/sm_versions f ile for each client. 

1|1.1.0|VERITAS-NetBackup|1


All Informix versions later than 7.31 UC4 dynamically read the appropriate 
information from the sm_versions file every time a backup/restore is executed. 

Informix versions 7.31 UC4 and earlier do not read from the sm_versions file. 
Instead, they read from the bar_version table in the sysutils database. 

If you are using Informix version 7.31 UC4 or earlier, insert this information into the 
table bar_version in the sysutils database 

bar_version bsa_version bar_sm sm_version

1 1.1.0 VERITAS-NetBackup 1


Note	 Make sure $BAR_BSALIB_PATH is correctly linked to NetBackup's 
infxbsa.[so,sl,a]. For more information, see “Troubleshooting” on page 79. 

Note	 The configuration parameter BAR_RETRY in the 
$INFORMIXDIR/etc/$ONCONFIG file specifies the number of times ON-Bar 
attempts to back up or restore the storage space or logical log if the first attempt 
fails. Informix recommends setting BAR_RETRY to 5. 
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Before attempting to configure NetBackup for Informix, complete the installation 
procedure as described in “Installation” on page 9. 

The following is the configuration procedure. 

1. Configuring Media Using Media and Device Management 

2. Setting the Maximum Jobs Per Client Property 

3. Configuring a NetBackup Policy 

4. Creating Scripts 

5. Configuring the bp.conf Files 

6. Testing NetBackup for Informix Configuration Settings 

The following sections in this chapter describe each of these steps in detail. 

To configure NetBackup for Informix from a Windows NetBackup server, see 
“Configuration Using the NetBackup Administration Console for Windows” on page 22. 

To configure NetBackup for Informix from a UNIX NetBackup server, see “Configuration 
Using the NetBackup Administration Console for UNIX” on page 37. 
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Configuration Using the NetBackup Administration 
Console for Windows 

Although the database agent is installed on the NetBackup client, some configuration 
procedures are performed using the NetBackup Administration Console on the server. 

These procedures include: 

◆ Configuring media using Media and Device Management 

◆ Setting the Maximum Jobs per Client property 

◆ Configuring a NetBackup policy 

◆ Testing NetBackup for Informix configuration settings 

See the next section for instructions on starting the NetBackup Administration Console. 

▼ To launch the NetBackup Administration Console for Windows 

1. Log on to the server as administrator. 

2.	 Choose Start > Programs > VERITAS NetBackup > NetBackup Administration 
Console. 
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The NetBackup Administration Console is displayed. 

Configuring Media Using Media and Device Management 
Use the Media and Device Management (Media Manager) to configure media for a 
NetBackup for Informix configuration. Refer to the NetBackup Media Manager System 
Administrator’s Guide for more information. 

The number of volumes required will depend on the devices used, the size of the Informix 
databases that you are backing up, and the frequency of backups. 

Setting the Maximum Jobs Per Client Property 
The Maximum jobs per client attribute value is figured with the following formula. 

Maximum Jobs per Client = Number of Streams x Number of Policies 

Where: 

◆	 Number of Streams is the number of backup streams between the database server and 
NetBackup. Each separate stream starts a new backup job on the client. 
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◆	 Number of Policies is the number of policies that may back up this client at the same 
time. This number can be greater than one. For example, a client may be in two 
policies in order to back up two different databases. These backup windows may 
overlap. 

Tip	 To avoid any problems, we recommend that you enter a high enough value for the 
Maximum jobs per client property to meet the number of jobs executed by 
Informix. 

▼ To set the Maximum jobs per client property using the Windows console 

1. In the left pane of the NetBackup Administration Console, expand Host Properties. 

2. Select Master Server. 

3.	 In the right pane, double-click on the server icon. 

The Master Server Properties dialog is displayed. 

4. In the Master Server Properties dialog, click Global Attributes. 

The default value is 1 for Maximum jobs per client. 

5. Change the Maximum jobs per client value to 99. 
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If you prefer to enter a lower value, calculate the value equal to the maximum number 
of backups allowed per client using the formula provided above. 

Configuring a NetBackup Policy 
A NetBackup policy defines the backup criteria for a specific group of one or more clients. 
These criteria include: 

◆ storage unit and media to use 

◆ backup schedules 

◆ clients to be backed up 

◆ script files to be executed on the clients 

To use NetBackup for Informix, at least one Informix-On-BAR policy with the appropriate 
schedules needs to be defined. A configuration can have a single policy that includes all 
clients or there can be many policies, some of which include only one client. 

In addition, a Standard type policy with a user-backup schedule type must be configured 
to back up the INFORMIX/etc files specified in the backup scripts. 

Most requirements for Informix-On-BAR policies are the same as for file system backups. 
In addition to the attributes described here, there are other attributes for a policy to 
consider. Refer to the NetBackup System Administrator’s Guide for Windows, Volume I or 
NetBackup System Administrator’s Guide for UNIX, Volume I for detailed configuration 
instructions and information on all the attributes available. 

Adding New Policies 

Use this procedure when configuring a policy from a Windows server or from a 
NetBackup Remote Administration Console host. 

▼ To add a new policy 

Note	 This policy name may be specified in the bp.conf file on the client. This is 
optional. Refer to “Configuring the bp.conf Files” on page 57 for details. 

1. Log on to the server as administrator. 

2. Start the NetBackup Administration Console. 

3.	 If your site has more than one master server, choose the one where you want to add 
the policy. 
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4.	 In the left pane, right-click Policies and choose New Policy. 

The Add a New Policy dialog is displayed. 

a. In the Policy name box, type a unique name for the new policy. 

b.	 Choose whether to use the wizard for configuring the policy. The wizard guides 
you through most of the setup process and simplifies it by automatically choosing 
default values that are good for most configurations. If necessary, you can change 
the defaults later by editing the policy. You will need to manually add entries to 
the Backup Selections list after completing the wizard. 

◆	 To use the wizard, select the Use Backup Policy Configuration Wizard box 
and click OK. The wizard starts and you create the policy by following the 
prompts. When prompted, select the Informix-On-BAR policy type. 

Note	 The Informix-On-BAR policy type will not appear in the drop-down list unless your 
server has a license key for NetBackup for Informix. 

◆	 If you require more control over the settings than the wizard provides, then 
do not select the Use Backup Policy Configuration Wizard box and proceed 
to step 5. 

5. Click OK. 
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A dialog is displayed in which you can specify the general attributes for the policy. 

6. From the Policy Type box, select the Informix-On-BAR policy type. 

7.	 Complete the entries on the Attributes tab as explained in “Description of 
Attributes.” 

8. Add other policy information: 

◆ To add schedules, see “Adding New Schedules.” 

◆ To add clients, see “Adding Clients to a Policy.” 

◆	 To add scripts to the Backup Selections list, see “Specifying the List of Backup 
Selections.” 

9. Click OK. The new policy is created. 
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Description of Attributes 

With a few exceptions, NetBackup manages a database backup like a file system backup. 
Policy attributes that are different for Informix backups are explained below. 

Your other policy attributes will vary according to your specific backup strategy and 
system configuration. Consult the NetBackup System Administrator’s Guide for Windows, 
Volume I or NetBackup System Administrator’s Guide for UNIX, Volume I for detailed 
explanations of the policy attributes. 

Description of Policy Attributes 

Attribute Description 

Policy type	 Determines the type of clients that can be in the policy and in some cases 
the types of backups that can be performed on those clients. 
To use NetBackup for Informix, you must have defined at least one 
Informix-On-BAR policy. 

Keyword phrase to For NetBackup for Informix, the keyword phrase entry is ignored. 
associate with the 
backup 

Adding New Schedules 

Each policy has its own set of schedules. These schedules control initiation of automatic 
backups and also specify when user operations can be initiated. 

An Informix backup requires an Application Backup schedule, which is created 
automatically when you create a Informix policy. The Application Backup schedule is 
used to initiate and manage the backup operation. You also need one or more Automatic 
Backup schedules, if you plan to have NetBackup perform automatic, scheduled backups. 

The following procedures explain how to configure the required schedule types, and how 
to add new schedules. The procedures start on the Policy dialog. To see the Policy dialog, 
double-click the policy name in the Policies list of the NetBackup Administration Console. 

▼ To configure an Application Backup schedule 

1. On the Policy dialog, click the Schedules tab. 

2.	 Double-click on the schedule named Default-Application-Backup. 

A dialog is displayed. 
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All Informix database operations are performed through NetBackup for Informix 
using an Application Backup schedule. This includes those backups started 
automatically. 

You must configure an Application Backup schedule for each Informix-On-BAR 
policy you create. If you do not do this, you will not be able to perform a backup. To 
help satisfy this requirement, an Application Backup schedule named 
Default-Application-Backup is automatically created when you configure a new 
Informix-On-BAR policy. 

3. Specify the other properties for the schedule as explained in “Schedule Properties.” 

The backup window for an Application Backup schedule must encompass the time 
period during which all NetBackup jobs, scheduled and unscheduled, will occur. This 
is necessary because the Application Backup schedule starts processes that are 
required for all NetBackup for Informix backups, including those started 
automatically. 

For example, assume that you: 

◆	 expect users to perform NetBackup operations during business hours, 0800 to 
1300. 

◆ configured automatic backups to start between 1800 and 2200. 

The Application Backup schedule must have a start time of 0800 and a duration of 14 
hours. 

Example Settings for an Application Backup schedule 

Type of Backup Schedule settings Description Settings 

Application 
Backup 

Retention The length of time backup images 
are stored. 

2 weeks 

Backup Window The time during which a NetBackup 
operation can be performed. 

Sunday through Saturday 

00:00:01 - 23:59:59 

Note	 The Application Backup schedule name may be specified in the bp.conf file on the 
client. This is optional. See “Configuring the bp.conf Files” on page 57 for details. 

Tip	 Set the time period for the Application Backup schedule for 24 hours per day, seven 
days per week. This ensures that your NetBackup for Informix operations are never 
locked out due to the Application Backup schedule. 
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▼ To configure an automatic backup schedule 

1. On the Policy dialog, click the Schedules tab. 

2. Click New. 

A dialog is displayed. The title bar shows the name of the policy to which you are 
adding the schedules. 

3. Specify a unique name for the schedule. 

4. Select the Type of backup. 

For information on the types of backups available for this policy, see “Types of 
Backups.” 

Refer to the following tables for example settings for an Automatic Backup schedule 

Type of Backup Schedule settings Description Settings 

Automatic Full 
Backup 

Retention The length of time to store the 
record of a backup. 

2 weeks 

Frequency Frequency determines how often 
a backup should be performed 

every week 

Backup Window The time during which a 
NetBackup operation can be 
performed. 

Sunday, 18:00:00 - 22:00:00 
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Type of Backup Schedule settings Description Settings 

Automatic 
Incremental Backup 

Retention The length of time to store the 
record of a backup. 

1 week 

Frequency Frequency determines how often 
a backup should be performed 

every day 

Backup Window The time during which a 
NetBackup operation can be 
performed. 

Sunday through Saturday 

18:00:00 - 22:00:00 

5. Specify the other properties for the schedule as explained in “Schedule Properties.” 

6. Click OK. 

Types of Backups 

Description of Backup Types for Informix 

Application Backup	 The Application Backup schedule enables user-controlled NetBackup 
operations performed on the client. At least one Application Backup 
schedule type must be configured for each Informix-On-BAR policy. The 
Default-Application-Backup schedule is automatically configured as an 
Application Backup schedule. 

Automatic Full A full backup copies all blocks into the backup set, skipping only datafile 
Backup	 blocks that have never been used. Note that a full backup is not the same as 

a whole database backup; full is an indicator that the backup is not 
incremental. 

A full backup has no effect on subsequent incremental backups, which is 
why it is not considered part of the incremental strategy. In other words, a 
full backup does not affect which blocks are included in subsequent 
incremental backups. 

Automatic 
Incremental Backup 

An incremental backup is a backup of only those blocks that have changed 
since a previous backup. 

Schedule Properties 

Some of the schedule properties have a different meaning for database backups than for a 
regular file system backup. These properties are explained in the following table. 
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Other schedule properties vary according to your specific backup strategy and system 
configuration. Consult the NetBackup System Administrator’s Guide for Windows, Volume I or 
NetBackup System Administrator’s Guide for UNIX, Volume I for detailed explanations of the 
schedule properties. 

Description of Schedule Properties 

Property Description 

Type of backup	 Specifies the type of backup that this schedule will control. The selection list 
shows only the backup types that apply to the policy you are configuring. 

For more information see the following section “Types of Backups.” 

Frequency	 This setting is used only for scheduled backups, and not for user-directed 
backups. Frequency specifies the period of time that will elapse until the 
next backup operation can begin on this schedule. For example, if the 
frequency is seven days and a successful backup occurs on Wednesday, the 
next full backup will not occur until the following Wednesday. Normally, 
incremental backups will have a shorter frequency than full backups. 

Calendar	 This setting is used only for scheduled backups, and not for user-directed 
backups. The Calendar option allows you to schedule backup operations 
based on specific dates, recurring week days, or recurring days of the 
month. 
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Description of Schedule Properties (Continued) 

Property Description 

Retention Frequency based scheduling 

The retention period for an Application Backup schedule refers to the 
length of time that NetBackup keeps backup images. 

The retention period for an Automatic Full Backup or Automatic 
Incremental Backup schedule controls how long NetBackup keeps records 
of when scheduled backups have occurred. 

The NetBackup scheduler compares the latest record to the frequency to 
determine whether a backup is due. This means that if you set the retention 
period to expire the record too early, the scheduled backup frequency will be 
unpredictable. However, if you set the retention period to be longer than 
necessary, the NetBackup catalog will accumulate unnecessary records. 
Therefore, set a retention period that is longer than the frequency setting for the 
schedule. 

For example, if the frequency setting is set to one week, set the retention 
period to be more than one week. 

Calendar based scheduling 

The retention period for an Application Backup schedule refers to the length 
of time that NetBackup keeps backup images. 

The retention period for an Automatic Full Backup or Automatic 
Incremental Backup schedule controls how long NetBackup keeps records 
of when scheduled backups have occurred. However, this setting is not 
significant for calendar based scheduling. 

Multiple copies	 If you are licensed for the Inline Tape Copy feature and wish to specify 
multiple copies for your Informix-On-BAR policy, configure Multiple 
copies on the Application Backup schedule. 

Adding Clients to a Policy 

The client list is the list of clients on which your On-BAR scripts are run during an 
automatic backup. A NetBackup client must be in at least one policy but can be in more 
than one. 

This procedure starts in the Policy dialog. To see the Policy dialog, double-click the policy 
name in the Policies list in the NetBackup Administration Console. 

Requirements for clients 

The following software must be installed on the client: 

◆ Informix 
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◆ NetBackup client or server 

◆ NetBackup for Informix 

◆ the backup or restore On-BAR script(s) 

▼ To add clients to a policy 

1. In the Policy dialog, click the Clients tab. 

2. Click New. 

3. Enter the name of the client you want to add. 

◆ Type the name into the client list and click OK. 

If NetBackup cannot detect the hardware and operating system, a dialog will be 
displayed so you can specify this information. 

OR 

◆ Click the Browse for Computer button to choose the client from the network: 

4.	 To add another client, repeat step 2 and step 3. If this is the last client, click OK to 
close the dialog. 

Specifying the List of Backup Selections 

The Backup Selections list in a database policy has a different meaning than for 
non-database policies. For example, in a Standard policy, the list contains files and 
directories to be backed up. In a database policy, you specify scripts to be run. 

Add scripts only if you are setting up a policy for automatic scheduling. All scripts listed 
in the Backup Selections list will be executed for the Automatic Full Backup or Automatic 
Incremental Backup schedules, as specified under the Schedules tab, and manual 
backups. NetBackup will start backups according to the order that scripts appear in the 
Backup Selections list. 

The following procedure starts in the Policy dialog. To see the Policy dialog, double-click 
the policy name in the Policies list in the NetBackup Administration Console. 

▼ To add scripts to the Backup Selections list 

1. In the Policy dialog, click the Backup Selections tab. 

2. Click New. 

3. Enter the name of the selection. 
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Scripts: 

◆ Type the name of the script. 

Be sure to specify the full pathname when listing On-BAR scripts. For example: 

install_path/netbackup/ext/dbext/informix/scripts/script_name 

OR 

◆ Click the Remote Folder button. 

The Browse window is displayed. Navigate to the script file and select the file. 
Click OK. 

Be sure that the On-BAR scripts listed here are installed on each client in the Client 
list. 

4. Click OK. 

Configuring a Standard Policy 
In addition to the Informix policy, you must also configure a Standard type policy. A 
Standard policy will enable the backup of the INFORMIXDIR/etc files specified in the 
scripts. 

Note	 The name of the policy must be specified in the backup scripts you modify on the 
client. 

▼ To Create a Standard Policy 

1. Add a new policy, as specified in “Configuring a NetBackup Policy.” 

2. Specify the general attributes for the policy: 

a. Select Standard for the policy type. 

b. Specify other attributes as desired. 

3. Add a schedule: 

a. Type the name of your schedule. 

b. In the Type of Backup box, select User Backup. 

A User Backup schedule enables user controlled NetBackup operations 
performed on the client. 
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c.	 In the Retention box, set the time period needed to retain two full backups of 
your database. 

For example, if your database is backed up once every Sunday morning, select a 
retention period of at least two weeks. 

d.	 In the Start Window section of the Schedules dialog, set the time of day when 
you want backup operations to be available to the user. 

Note	 You do not need to configure a file list for this policy because it will be a User 
Backup type schedule. 

4.	 Specify the clients that you will be backing up. The client must have: 

◆ Informix installed 

◆ NetBackup for Informix installed 

5. Click OK. 

The Add New Policy dialog box closes. The policy you just configured appears in the 
policy list. 
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Configuration Using the NetBackup Administration 
Console for UNIX 

Although the database agent is installed on the NetBackup client, some configuration 
procedures are performed using the NetBackup Administration Console on the server. 

These procedures include: 

◆ Configuring media using Media and Device Management 

◆ Setting the Maximum Jobs per Client property 

◆ Configuring a NetBackup policy 

◆ Testing NetBackup for Informix configuration settings 

See the next section for instructions on starting the NetBackup Administration Console. 

▼ To launch the NetBackup Administration Console for UNIX 

1. Log onto the UNIX server as root. 

2.	 Start the NetBackup Administration Console by executing: 

install_path/netbackup/bin/jnbSA & 

The login dialog is displayed. 

3.	 Type the name of the master server where you initially want to manage NetBackup. 
You can specify any NetBackup master server. Indicate the User and Password. 
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4. Click Login. The NetBackup Administration Console is displayed. 

Configuring Media Using Media and Device Management 
Use the Media and Device Management (Media Manager) to configure media for a 
NetBackup for Informix configuration. Refer to the NetBackup Media Manager System 
Administrator’s Guide for more information. 

The number of volumes required will depend on the devices used, the size of the Informix 
databases that you are backing up, and the frequency of backups. 

Setting the Maximum Jobs Per Client Property 
The Maximum jobs per client attribute value is figured with the following formula. 

Maximum Jobs per Client = Number of Streams x Number of Policies 

Where: 

◆	 Number of Streams is the number of backup streams between the database server and 
NetBackup. Each separate stream starts a new backup job on the client. 
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◆	 Number of Policies is the number of policies that may back up this client at the same 
time. This number can be greater than one. For example, a client may be in two 
policies in order to back up two different databases. These backup windows may 
overlap. 

Tip	 To avoid any problems, we recommend that you enter a high enough value for the 
Maximum jobs per client property to meet the number of jobs executed by 
Informix. 

▼	 To set the Maximum jobs per client property using the NetBackup Administration 
Console for UNIX 

1.	 In the left pane of the NetBackup Administration Console, expand Host Properties. 
Select Master Servers. 

2.	 In the right pane, double-click on the server icon. Click Global Attributes. 

The Master Server Properties dialog is displayed. 

The default value is 1 for Maximum jobs per client. 

3. Change the Maximum jobs per client value to 99. 
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If you prefer to enter a lower value, calculate the value equal to the maximum number 
of backups allowed per client using the formula provided above. 

Configuring a NetBackup Policy 
A NetBackup policy defines the backup criteria for a specific group of one or more clients. 
These criteria include: 

◆ storage unit and media to use 

◆ backup schedules 

◆ clients to be backed up 

◆ script files to be executed on the clients 

To use NetBackup for Informix, at least one Informix-On-BAR policy with the appropriate 
schedules needs to be defined. A configuration can have a single policy that includes all 
clients or there can be many policies, some of which include only one client. 

In addition, a Standard type policy with a user-backup schedule type must be configured 
to back up the INFORMIX/etc files specified in the backup scripts. 

Most requirements for Informix-On-BAR policies are the same as for file system backups. 
In addition to the attributes described here, there are other attributes for a policy to 
consider. Refer to the NetBackup System Administrator’s Guide for Windows, Volume I or 
NetBackup System Administrator’s Guide for UNIX, Volume I for detailed configuration 
instructions and information on all the attributes available. 

Adding New Policies 

Use this procedure when configuring a policy from a UNIX server. 

▼ To add a new policy 

Note	 This policy name may be specified in the bp.conf file on the client. This is 
optional. Refer to “Configuring the bp.conf Files” on page 57 for details. 

1. Log onto the server as root. 

2. Start the NetBackup Administration Console. 

3.	 If your site has more than one master server, choose the one to which you want to add 
the policy. 
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4.	 In the left pane, click on Policies. The right pane splits into an All Policies pane and a 
details pane. 

5.	 In the All Policies pane, right-click on the Master Server, and click New. 

The Add a New Policy dialog is displayed. 

a. In the Policy name box, type a unique name for the new policy. 

b.	 Choose whether to use the wizard for configuring the policy. The wizard guides 
you through most of the setup process and simplifies it by automatically choosing 
default values that are good for most configurations. If necessary, you can change 
the defaults later by editing the policy. You will need to manually add entries to 
the Backup Selections list after completing the wizard. 

◆	 To use the wizard, select the Use add policy wizard box and click OK. The 
wizard starts and you create the policy by following the prompts. When 
prompted, select the Informix-On-BAR policy type. 

Note	 The Informix-On-BAR policy type will not appear in the drop-down list unless your 
server has a license key for NetBackup for Informix. 

◆	 If you require more control over the settings than the wizard provides, do not 
select the Use add policy wizard box and proceed to step 6. 

6. Click OK. 
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A dialog is displayed in which you can specify the general attributes for the policy. 

7. From the Policy type box, select the Informix-On-BAR policy type. 

8.	 Complete the entries on the Attributes tab as explained in “Description of Attributes” 
and click Apply to save the attribute entries. 

9.	 Add other policy information: 

◆ To add schedules, see “Adding New Schedules.” 

◆ To add clients, see “Adding Clients to a Policy.” 

◆ To add scripts, see “Specifying the List of Backup Selections.” 

10. Click Apply. The new policy is created. 
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Description of Attributes 

With a few exceptions, NetBackup manages a database backup like a file system backup. 
Policy attributes that are different for Informix backups are explained below. 

Your other policy attributes will vary according to your specific backup strategy and 
system configuration. Consult the NetBackup System Administrator’s Guide for Windows, 
Volume I or NetBackup System Administrator’s Guide for UNIX, Volume I for detailed 
explanations of the policy attributes. 

Description of Policy Attributes 

Attribute Description 

Policy type	 Determines the type of clients that can be in the policy and in some cases 
the types of backups that can be performed on those clients. 
To use NetBackup for Informix, you must have defined at least one 
Informix-On-BAR policy. 

Keyword phrase to For NetBackup for Informix, the keyword phrase entry is ignored. 
associate with the 
backup 

Adding New Schedules 

Each policy has its own set of schedules. These schedules control initiation of automatic 
backups and also specify when user operations can be initiated. 

An Informix backup requires at least two specific schedule types: an Application Backup 
schedule and an Automatic Backup schedule. You can also create additional schedules. 

The following procedures explain how to configure the required schedule types, and how 
to add other new schedules. The procedures start from the Policy dialog. To see the Policy 
dialog, double click the policy in the policy list in the left pane of the NetBackup 
Administration Console. 

▼ To configure an Application Backup schedule 

1. In the Policy dialog, click the Schedules tab. 

2.	 In the Schedule list, double-click on the schedule named 
Default-Application-Backup. 

A dialog is displayed. The title bar shows the name of the policy to which you are 
adding the schedule. 
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All Informix database operations are performed through NetBackup for Informix 
using an Application Backup schedule. This includes those backups started 
automatically. 

You must configure an Application Backup schedule for each Informix-On-BAR 
policy you create. If you do not do this, you will not be able to perform a backup. To 
help satisfy this requirement, an Application Backup schedule named 
Default-Application-Backup is automatically created when you configure a new 
Informix-On-BAR policy. 

3. Specify the other properties for the schedule as explained in “Schedule Properties.” 

The backup window for an Application Backup schedule must encompass the time 
period during which all NetBackup jobs, scheduled and unscheduled, will occur. This 
is necessary because the Application Backup schedule starts processes that are 
required for all NetBackup for Informix backups, including those started 
automatically. 

For example, assume that you: 

◆	 expect users to perform NetBackup operations during business hours, 0800 to 
1300. 

◆ configured automatic backups to start between 1800 and 2200. 

The Application Backup schedule must have a start time of 0800 and a duration of 14 
hours. 

Tip	 Set the time period for the Application Backup schedule for 24 hours per day, seven 
days per week. This ensures that your NetBackup for Informix operations are never 
locked out due to the Application Backup schedule. 

Example Settings for an Application Backup schedule 

Type of Backup Schedule settings Description Settings 

Application 
Backup 

Retention The length of time backup images 
are stored. 

2 weeks 

Backup Window The time during which a NetBackup 
operation can be performed. 

Sunday through Saturday 

00:00:01 - 23:59:59 

Note	 The Application Backup schedule name may be specified in the bp.conf file on the 
client. This is optional. See “Configuring the bp.conf Files” on page 57 for details. 
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▼ To configure an automatic backup schedule 

1. In the Policy dialog, click the Schedules tab. 

2. Click New. 

A dialog is displayed. The title bar shows the name of the policy to which you are 
adding the schedules. 

3. Specify a unique name for the schedule. 

4. Select the Type of Backup. 

For information on the types of backups available for this policy, see “Types of 
Backups.” 
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Refer to the following tables for example settings for an Automatic Backup schedule. 

Type of Backup Schedule settings Description Settings 

Automatic Full 
Backup 

Retention The length of time to store the 
record of a backup. 

2 weeks 

Frequency Frequency determines how often 
a backup should be performed 

every week 

Backup Window The time during which a 
NetBackup operation can be 
performed. 

Sunday, 18:00:00 - 22:00:00 

Automatic 
Incremental Backup 

Retention The length of time to store the 
record of a backup. 

1 week 

Frequency Frequency determines how often 
a backup should be performed 

every day 

Backup Window The time during which a 
NetBackup operation can be 
performed. 

Sunday through Saturday 

18:00:00 - 22:00:00 

5. Specify the other properties for the schedule as explained in “Schedule Properties.” 

6. If this is the last schedule, click OK. 

Types of Backups 

Description of Backup Types for Informix


Application Backup	 The Application Backup schedule enables user-controlled NetBackup 
operations performed on the client. At least one Application Backup 
schedule type must be configured for each Informix-On-BAR policy. The 
Default-Application-Backup schedule is automatically configured as an 
Application Backup schedule. 

Automatic Full A full backup copies all blocks into the backup set, skipping only datafile 
Backup	 blocks that have never been used. Note that a full backup is not the same as 

a whole database backup; full is an indicator that the backup is not 
incremental. 

A full backup has no effect on subsequent incremental backups, which is 
why it is not considered part of the incremental strategy. In other words, a 
full backup does not affect which blocks are included in subsequent 
incremental backups. 
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Description of Backup Types for Informix


Automatic An incremental backup is a backup of only those blocks that have changed 
Incremental Backup since a previous backup. 

Schedule Properties 

Some of the schedule properties have a different meaning for database backups than for a 
regular file system backup. These properties are explained in the following table. 

Other schedule properties vary according to your specific backup strategy and system 
configuration. Consult the NetBackup System Administrator’s Guide for Windows, Volume I or 
NetBackup System Administrator’s Guide for UNIX, Volume I for detailed explanations of the 
schedule properties. 

Description of Schedule Properties


Property Description 

Type of backup	 Specifies the type of backup that this schedule will control. The selection list 
shows only the backup types that apply to the policy you are configuring. 

For more information see the following section “Types of Backups.” 

Frequency	 This setting is used only for scheduled backups, and not for user-directed 
backups. Frequency specifies the period of time that will elapse until the 
next backup operation can begin on this schedule. For example, if the 
frequency is seven days and a successful backup occurs on Wednesday, the 
next full backup will not occur until the following Wednesday. Normally, 
incremental backups will have a shorter frequency than full backups. 

Calendar	 This setting is used only for scheduled backups, and not for user-directed 
backups. The Calendar option allows you to schedule backup operations 
based on specific dates, recurring week days, or recurring days of the 
month. 
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Description of Schedule Properties (Continued)


Property Description 

Retention Frequency based scheduling 

The retention period for an Application Backup schedule refers to the 
length of time that NetBackup keeps backup images. 

The retention period for an Automatic Full Backup or Automatic 
Incremental Backup schedule controls how long NetBackup keeps records 
of when scheduled backups have occurred. 

The NetBackup scheduler compares the latest record to the frequency to 
determine whether a backup is due. This means that if you set the retention 
period to expire the record too early, the scheduled backup frequency will be 
unpredictable. However, if you set the retention period to be longer than 
necessary, the NetBackup catalog will accumulate unnecessary records. 
Therefore, set a retention period that is longer than the frequency setting for the 
schedule. 

For example, if the frequency setting is set to one week, set the retention 
period to be more than one week. 

Calendar based scheduling 

The retention period for an Application Backup schedule refers to the length 
of time that NetBackup keeps backup images. 

The retention period for an Automatic Full Backup or Automatic 
Incremental Backup schedule controls how long NetBackup keeps records 
of when scheduled backups have occurred. However, this setting is not 
significant for calendar based scheduling. 

Multiple copies	 If you are licensed for the Inline Tape Copy feature and wish to specify 
multiple copies for your Informix-On-BAR policy, configure Multiple 
copies on the Application Backup schedule. 

Adding Clients to a Policy 

The client list is the list of clients on which your NetBackup for Informix backups will be 
performed. A NetBackup client must be in at least one policy but can be in more than one. 

This procedure starts from the Policy dialog. To see the Policy dialog, double-click the 
policy in the policy list in the left pane of the NetBackup Administration Console. 

Requirements for clients 

The following software must be installed on the client: 

◆ Informix 

◆ NetBackup client or server 
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◆ NetBackup for Informix 

◆ the backup or restore On-BAR script(s) 

▼ To add clients to a policy 

1. In the Policy dialog, click the Clients tab. 

2. On the Clients tab, click New. 

The Add Client dialog is displayed. The title bar shows the name of the policy where 
you are adding clients. 

3. In the Client name text box, type the name of the client that you are adding. 

4. Choose the Hardware and operating system type and click Add. 

5.	 If this is the last client, click OK. If you are going to add more clients, repeat step 3 and 
step 4. 

Specifying the List of Backup Selections 

The Backup Selections list in a database policy has a different meaning than for 
non-database policies. For example, in a Standard policy, the list contains files and 
directories to be backed up. In a database policy, the list contains script. 

Add scripts only if you are setting up a policy for automatic scheduling. All scripts listed 
in the Backup Selections list will be executed for the Automatic Full Backup or Automatic 
Incremental Backup schedules as specified under the Schedules tab. NetBackup will start 
backups by running the scripts in the order that they appear in the Backup Selections list. 

The following procedure starts from the Policy dialog. To see the Policy dialog, 
double-click the policy in the Policies list in the NetBackup Administration Console. 
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▼ To add scripts to the Backup Selections List 

1. In the Policy dialog, click the Backup Selections tab. 

2. Click New. 

A dialog is displayed. The title bar shows the name of the policy to which you are 
adding the scripts. 

3. Type the name of the Informix script. 

Be sure to specify the full pathname when listing On-BAR scripts. For example: 

install_path/netbackup/ext/dbext/informix/scripts/script_name


Be sure that the On-BAR scripts listed here are installed on each client in the Client 
list. 

4. Click Add. 

5. To add more scripts, repeat . 

6. When you are finished adding backup selections, click OK. 
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Configuring a Standard Policy 
In addition to the Informix policy, you must also configure a Standard type policy. A 
Standard policy will enable the backup of the INFORMIXDIR/etc files specified in the 
scripts. 

Note	 The name of the policy must be specified in the backup scripts you modify on the 
client. 

▼ To Create a Standard Policy 

1. Add a new policy, as specified in “Configuring a NetBackup Policy.” 

2. Specify the general attributes for the policy: 

a. Select Standard for the policy type. 

b. Specify other attributes as desired. 

3. Add a schedule: 

a. Type the name of your schedule. 

b. In the Type of Backup box, select User Backup. 

A User Backup schedule enables user controlled NetBackup operations 
performed on the client. 

c.	 In the Retention box, set the time period needed to retain two full backups of 
your database. 

For example, if your database is backed up once every Sunday morning, select a 
retention period of at least two weeks. 

d.	 In the Start Window section of the Schedules dialog, set the time of day when 
you want backup operations to be available to the user. 

Note	 You do not need to configure a file list for this policy because it will be a User 
Backup type schedule. 

4.	 Specify the clients that you will be backing up. The client must have: 

◆ Informix installed 

◆ NetBackup for Informix installed 
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5. Click OK. 

The Add New Policy dialog box closes. The policy you just configured appears in the 
policy list. 
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Creating Scripts 
For more information on ON-BAR scripts, see the Informix-OnLine Dynamic Server Backup 
and Restore Guide (available from Informix). 

The following example scripts were included with the NetBackup for Informix 
installation: 

informix_dbspace_list

informix_logical_log_backup

informix_onbar_backup_of_dbspace1

informix_onbar_backup_of_rootdbs

informix_onbar_backup_of_rootdbs_and_dbspace1

informix_onbar_backup_using_file_list

informix_onbar_restore_dbspace1

informix_onbar_restore_rootdbs

infx_remove_expired_backup


These scripts were installed in the following directory: 

install_path/netbackup/ext/db_ext/informix/scripts


Be sure to modify these scripts for your environment. 

Although each script can have multiple Informix On-BAR Utility operations, a separate 
script is required for each type of operation. For example, you need separate scripts for 
backups and restores. 

Caution	 Always specify the correct script when configuring automatic backups or when 
starting operations through NetBackup. NetBackup for Informix will not 
generate an error if a restore script is used for a backup operation or a backup 
script is used for a restore operation. 

Instructions for Modifying Scripts 

Note	 If you do not include an su - user (user is the Informix administrator account) in 
your scripts, they will not run with the proper permissions and environment 
variables. The result will be problems with your database backups or restores. 

▼ To modify NetBackup for Informix scripts 

1.	 If necessary, copy the example scripts to a different directory on your client. On-BAR 
scripts can be located anywhere on the client. 

2. Set the access permissions of these scripts to 775. 
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chmod 775 <script_name> 

3. Modify the informix_onbar_backup_of_rootdbs script 

a.	 Use a text editor to open the informix_onbar_backup_of_rootdbs script. 
The following example uses the vi text editor. 

vi informix_onbar_backup_of_rootdbs


The following appears. 

#!/bin/sh


# Replace xxxxx below with the extention used for your onconfig file. 

ONCONFIG=onconfig.xxxxx


# Replace yyyyy below with the Informix home path. 

INFORMIXDIR=/yyyyy/informix


# Replace zzzzz below with the name of the Informix server. 

INFORMIXSERVER=zzzzz


# Replace informix_etc below with the name of the NetBackup server policy 

# to be used to back up the $INFORMIXDIR/etc directory. 

INFX_ETC_POLICY=informix_etc


echo "Started `date`"


export ONCONFIG

echo "exported ONCONFIG"


export INFORMIXDIR

echo "exported INFORMIXDIR"


export INFORMIXSERVER

echo "exported INFORMIXSERVER"


echo "INFXBSA_SERVER = $INFXBSA_SERVER"

echo "INFXBSA_SCHEDULED = $INFXBSA_SCHEDULED"

echo "INFXBSA_USER_INITIATED = $INFXBSA_USER_INITIATED"

echo "INFXBSA_FULL = $INFXBSA_FULL"

echo "INFXBSA_INCR = $INFXBSA_INCR"

echo "INFXBSA_POLICY = $INFXBSA_POLICY"


RETURN_STATUS=0


if [ "${INFXBSA_INCR}" = "1" ]

then

# Netbackup has started an incremental backup. 

echo "$INFORMIXDIR/bin/onbar -b -L 1 rootdbs"

$INFORMIXDIR/bin/onbar -b -L 1 rootdbs
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RETURN_STATUS=$?

else


echo "$INFORMIXDIR/bin/onbar -b -L 0 rootdbs"

$INFORMIXDIR/bin/onbar -b -L 0 rootdbs

RETURN_STATUS=$?


fi


if [ "$RETURN_STATUS" -eq "0" ]

then


# Initiate a backup of the directory that contains the onconfig, 

# sqlhosts, oncfg_$INFORMIXSERVER.SERVERNUM, and ixbar.SERVERNUM 

# files after doing the backup. 


echo "bpbackup -p $INFX_ETC_POLICY -w 0 $INFORMIXDIR/etc"

/usr/openv/netbackup/bin/bpbackup -p $INFX_ETC_POLICY -w 0 $INFORMIXDIR/etc

BPBACKUP_STATUS=$?


if [ "$BPBACKUP_STATUS" -ne "0" ]

then

echo ""

echo "bpbackup of $INFORMIXDIR/etc returned $BPBACKUP_STATUS"


fi

fi


echo "Finished `date`"


echo "exit $RETURN_STATUS"

echo ""


exit $RETURN_STATUS


b. Follow the instructions in the informix_onbar_backup_of_rootdbs script. 

Note	 Test the scripts you just created. Refer to “Testing NetBackup for Informix 
Configuration Settings” on page 58. 
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Environment Variables 
When a schedule executes, NetBackup sets environment variables for the local shell 
scripts to use when performing the backup. The echo lines are used to show what 
Informix environment variables are available. These variables can be used to perform 
conditional functions inside the scripts. These variables are local to the Informix shell 
script. 

NetBackup sets the following variables: 

INFXBSA_FULL Set to 1 if this is a full backup (Automatic Full Backup). 

INFXBSA_INCR	 Set to 1 if this is an incremental backup (Automatic Incremental 
Backup). 

INFXBSA_SCHEDULED	 Set to 1 if this is a scheduled backup (Automatic Full Backup or 
Automatic Incremental Backup). 

INFXBSA_USER_INITIATED	 Set to 1 if this is a user-initiated backup (Application Backup 
backup). 

These variables can be set by the Informix user either in the script or manually from the 
command line in the same environment that onbar is executed from. 

INFXBSA_SERVER Name of the NetBackup server. 

INFXBSA_LOGICAL_POLICY	 Name of the policy to be used for a logical logs backup. If this 
variable is set, NetBackup will back up the logical logs using 
this policy. 

INFXBSA_LOGICAL_SCHED	 Name of the schedule to be used for a logical logs backup. If this 
variable is set, NetBackup can distinguish and will back up 
logical logs using this schedule. 

INFXBSA_POLICY	 Name of the Informix-On-BAR policy. If this variable is set, 
NetBackup will back up Informix databases using this policy. 

INFXBSA_SCHED	 Name of the Application Backup schedule. If this variable is set, 
NetBackup will back up Informix databases using this 
schedule. 
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Configuring the bp.conf Files 
The administrator can add options to the NetBackup bp.conf file on the NetBackup 
master server. The administrator can create an additional bp.conf file in the home 
directory of the Informix user’s account used for the backup or restore. 

Options for netbackup/bp.conf On the Server 
To prevent unloading and reloading tapes between dbspace backups, add the following 
options to the NetBackup main bp.conf file that is in the netbackup directory on the 
NetBackup master server. 

MEDIA_UNMOUNT_DELAY=200

MEDIA_REQUEST_DELAY=30


Create a bp.conf File on the Client 
Before using NetBackup for Informix, you can create a bp.conf file in the home directory 
of the Informix user’s account used for the backup, on the NetBackup client. 

Note	 The path to this directory can be equal to the value of the $INFORMIXDIR variable, 
but that is not always the case. 

For example, if the home directory is /informix, the path is: 

/informix/bp.conf 

After creating a bp.conf file in the Informix home directory, add the following option to 
it: 

BPBACKUP_POLICY=informix_policy

BPBACKUP_SCHED=informix_sched (Default-Application-Backup Schedule)

SERVER=server_name

CLIENT_READ_TIMEOUT=1800


This ensures that NetBackup for Informix will use the correct Informix-On-BAR policy for 
backups. 

Note	 NetBackup uses the bp.conf file in the Informix user’s home directory only for 
Informix-On-BAR policies. 
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Testing NetBackup for Informix Configuration Settings 
After configuring the master server for NetBackup for Informix, test the configuration 
settings. For a description of status codes, refer to the NetBackup Troubleshooting Guide for 
UNIX and Windows. 

NetBackup Administration Console for Windows 
Use this procedure to test a policy configuration from a Windows server or from the 
Remote Administration Console. 

▼ To test the configuration settings on a Windows server 

1. Log onto the server as administrator. 

2. Start the NetBackup Administration Console. 

3. In the left pane, click Policies. The policy list appears in the right pane. 

4. Click on the policy you wish to test. 

5.	 Choose Actions > Manual Backup. 

The Manual Backup dialog is displayed. 

The Schedules pane contains the name of a schedule (or schedules) configured for the 
policy you are going to test. The Clients pane contains the name of the client(s) listed 
in the policy you are going to test. 

6. Follow the instructions on the dialog. 
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7. Click Activity Monitor on the NetBackup Administration Console. 

If the manual backup does not exit with a successful status, refer to the 
Troubleshooting chapter. 

NetBackup Administration Console for UNIX 
Use this procedure to test a policy configuration on the NetBackup Administration 
Console for UNIX. 

▼ To test the configuration settings on a UNIX server 

1. Log onto the server as root. 

2. Start the NetBackup Administration Console. 

3.	 In the left pane, click Policies. 

The right pane splits into an All Policies pane and a details pane. 

4. In the All Policies pane, click the policy you wish to test. 

5. Choose Actions > Manual Backup. 
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The Manual Backup dialog is displayed. 

The Schedules pane contains the name of a schedule (or schedules) configured for the 
policy you are going to test. The Clients pane contains the name of the client(s) listed 
in the policy you are going to test. 

6. Follow the instructions on the dialog. 

7. Click Activity Monitor on the NetBackup Administration Console. 
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If the manual backup does not exit with a successful status, refer to the 
Troubleshooting chapter. 
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4


When all installation and configuration is complete, you can start Informix backups and 
restores through NetBackup or execute the onbar command directly. 

This chapter contains the following sections: 

◆ Performing a Backup 

◆ Browsing Backups 

◆ Performing a Restore 

Caution	 Always specify the correct On-BAR script when configuring automatic backups 
or when starting operations through NetBackup. NetBackup for Informix will 
not generate an error if a restore On-BAR script file is used for a backup 
operation or a backup On-BAR script is used for a restore operation. 
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Performing a Backup 
The Informix On-BAR Utility supports four different types of backups. The following 
provides a brief description of each backup type. See the Informix Backup and Restore Guide 
for more information. 

Backup Type Description 

Level 0 Backup 
(Full) 

Level 1 Backup 
(Incremental) 

Level 2 Backup 
(Not supported by 
NetBackup) 

Logical Log 
Backups 

An Informix full backup (level 0 backup) includes all the records in 
the selected dbspaces. This is the only type of backup that allows a 
complete restore without performing any recovery steps. 

An Informix incremental backup (level 1 backup) backs up records 
that have changed since the last level 0 backup in the selected 
dbspaces. 

An Informix Level 2 backup backs up records that have changed 
since the last level 1 backup in the selected dbspaces. This type of 
backup is not supported by NetBackup. Level 2 backups can be 
done, however, by keeping track of the previous backup type with 
the On-Bar script. 

An Informix logical-log backup backs up the logical logs that have 
filled. By using the Informix ALARMPROGRAM configuration 
option, these backups can be scheduled, started manually, or started 
on demand when the logical logs fill. 

Backup Strategy 
The backup strategy in the following example is for a database that requires frequent 
backups in order to provide protection against disk failure. This strategy is as follows: 

1.	 Perform an Informix full backup (level 0) every Friday night. This backs up the 
selected dbspaces. 

2. Back up the $INFORMIXDIR/etc directory once a day. 

3. Perform an Informix incremental backup (level 1) each night. 

4.	 Configure the Informix ALARMPROGRAM to start a logical-log backup as the logs 
fill. 
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5.	 If you do not want to wait for log files to fill, you can set up a separate NetBackup 
policy and then schedule a full logical-log backup to occur as often as necessary. 

Note	 It is especially important to have a good strategy for backing up logical-log files, 
since they are needed for database recovery. 

Automatic Backup of an Informix-On-BAR Policy 
The most convenient way to back up your database is to set up schedules for automatic 
backups. When the NetBackup scheduler invokes a schedule for an automatic backup, the 
On-BAR scripts run: 

◆ In the same order as they appear in the file list 

◆ On all clients that have them (that is, matching path names) 

The On-BAR scripts will start the database backup. 

To add a new schedule or change an existing schedule for automatic backups, follow the 
guidelines in “Configuring a NetBackup Policy” on page 25. 

Manual Backup of an Informix-On-BAR Policy 
The administrator on the master server can use the NetBackup server software to 
manually execute an Automatic Backup schedule for the Informix-On-BAR policy. For 
instructions on manually executing a policy, see “Testing NetBackup for Informix 
Configuration Settings” on page 58. 
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User-Directed Backups 
This section describes the following procedures for performing user-directed backups:


◆ Using xbp to Perform a Backup


◆ Using the onbar Command to Perform a Backup


Using xbp to Perform a Backup 

Note xbp is not supported on AIX platforms. 

The following describes how to use xbp to back up your database. Refer to the xbp man 
page and the online help in the interface for detailed instructions on using xbp to back up 
the database. 

▼ To perform a backup using xbp 

1. Log in as the Informix administrator or as root. 

If you are already logged in under a different user account, use the su - command to 
change to the Informix administrator. 

2.	 Execute xbp on the client to which you want to backup a database. 

install_path/netbackup/bin/xbp 

3.	 In the Directory to Search Box, type the path name of the location of the On-BAR 
scripts. For example: 

install_path/netbackup/ext/db_ext/informix/scripts/


4. Choose File > Browse File System for Backup Scripts. 

5. Select the backup script from the Files pane. 

6.	 Choose Backup > Backup Database Using Selected Scripts. The xbp_confirm dialog 
displays. 

7.	 Click OK. 

A NetBackup process called bphdb starts the On-BAR script on the client. 

8. View the status of the script execution. 
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a.	 Choose Backup > Report Progress Of Backup.... 

The xbp_progress dialog displays. 

b. Select the log file for your backup. 

The Contents of Selected Log File pane displays only the status of the script 
execution. A status =0 message indicates that the script was successfully 
completed. Go to Step 9 for a detailed status report. For a status other than 0, refer 
to the Troubleshooting section of this manual. For additional information, check 
the output of the script. 

9. View the log file for the NetBackup operation. 

a.	 Change directories to the bphdb log directory. 

cd install_path/netbackup/logs/bphdb 

b.	 Open the log file with the tail option. 

tail -f log.mmddyy 

A Backup completed SUCCESSFULLY message indicates a successfully completed 
NetBackup operation. 

Using the onbar Command to Perform a Backup 

You can start a backup by executing the onbar command from the UNIX command line 
on the client. See the Informix Backup and Restore Guide for details on using the onbar 
command. 
Chapter 4, Using NetBackup for Informix 67 



Browsing Backups 
Browsing Backups 
This section describes the following procedures for browsing backups:


◆ Using xbp to Browse


◆ Using bplist to Browse


Using xbp to Browse 

Note xbp is not supported on AIX platforms. 

The following describes how to use xbp to browse your database backups. Refer to the 
xbp man page and the online help in the interface for detailed instructions on using xbp to 
browse database backups. 

1. Log in as the Informix administrator or as root. 

If a different user account is used, use the su command to change to the Informix 
administrator. 

2.	 Execute xbp on the client. 

install_path/netbackup/bin/xbp 

The xbp dialog is displayed. 

3.	 From the File menu, click Configuration. 

The xbp_config dialog displays. 

a. In the Policy type of image to browse, specify the Informix-On-BAR policy. 

b. Click OK to close the dialog. 

c. In the Directory To Search Box, enter / as the directory to search. 

d. Set the Range of Dates to include the date of your backup. 

e. Enter 9 in the Directory Depth Box. 

f.	 From the File menu, select Browse Backups (Restore). A list of backup images 
appears in the dialog. 
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Using bplist to Browse 
Use the bplist command to browse Informix backup history on the master server. The 
result is the list of dump-file names. The following example uses bplist to search all 
Informix backups for a client named cabbage: 

The -t 6 on this command specifies the Informix backups (dumps). Refer to the 
bplist(1M) man page for more information on this command. 
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Performing a Restore 
The following procedure explains how to restore your database to the level of your last 
full or partial backup plus all transactions through the last incremental. It includes steps 
for recovering all of your files. For some types of failures, you will not have to perform all 
of these steps. Refer to the Informix-OnLine Dynamic Server Backup and Restore Guide for 
more information on the steps described here and which step(s) to perform for a specific 
type of failure: 

1.	 Salvage the logical-log files before replacing any disks that have failed: 

onbar -l -s 

2.	 If you need to restore the $ONCONFIG file, sqlhosts file, emergency boot file, or the 
oncfg_$INFORMIX SERVER.SERVERNUM file, use the NetBackup Administrator 
Console - Java interface as follows: 

a. Change to the $INFORMIXDIR/etc directory: 

cd $INFORMIXDIR/etc 

b.	 Start the java interface, select the files that you want to restore, and then start the 
restore. 

3.	 Use onbar to perform the physical restore of the damaged dbspaces: 

onbar -r -p dbspace1 dbspace2 

4.	 Perform a logical restore of the dbspaces that you physically restored: 

onbar -r -l 

User-Directed Restore 
All restores must be started from the NetBackup for Informix client. Prior to the execution 
of a restore, a backup must have been successfully completed or an error will occur during 
the execution. 

Note You cannot execute restore operations from the server. 

This section describes the following procedures for performing user-directed restores:


◆ Using xbp


◆ Using the onbar Command to Perform a Restore
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Using xbp 
The following describes how to use xbp to restore your database. Refer to the UNIX client 
online help for detailed instructions on using xbp to restore database backups. 

1. Log in as the Informix administrator or as root. 

If a different user account is used, use the su- command to switch to the Informix 
administrator. 

2.	 Execute xbp on the client to which you want to restore a database. 

install_path/netbackup/bin/xbp 

3.	 In the Directory to Search Box, type in the path name of the location of the On-BAR 
scripts. For example: 

install_path/netbackup/ext/db_ext/informix/scripts/


4. Choose File > Browse File System for Restore Scripts. The xbp dialog is displayed. 

5. Select the restore script from the Files pane. 

6.	 Choose Restore > Restore Database Using Selected Scripts. The xbp_confirm dialog 
is displayed. 

7.	 Click OK. 

A NetBackup process called bphdb starts the On-BAR script on the client. 

8. View the status of the script execution. 

a.	 Choose Restore > Report Progress Of Restore.... The xbp_progress dialog is 
displayed. 

b. Select the log file for your restore. 

The Contents of Selected Log File pane displays only the status of the script 
execution. A status =0 message indicates that the script was successfully 
completed. Go to Step 9 for a detailed status report. For a status other than 0, refer 
to the Troubleshooting section of this manual. 

9. View the log file for the NetBackup operation. 

a.	 Change directories to the bphdb log directory. 

cd /install_path/netbackup/logs/bphdb 
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b.	 Open the log file with the tail option. 

tail -f log.mmddyy 

A Restore completed SUCCESSFULLY message indicates a successfully completed 
NetBackup operation. 

Using the onbar Command to Perform a Restore 
You can also use the onbar command from the UNIX command line on the client. See the 
Informix Backup and Restore Guide for details about the onbar command. 

Redirecting a Restore to a Different Client 
You have the option to restore an Informix Database to a client other than the one that 
originally supplied the backup. This process of restoring data to a different client is called 
a redirected restore. 

In order to perform a redirected restore, the following conditions must be true: 

◆ The source and destination clients must have identical OS versions and bit-levels. 

◆ The source and destination clients must have identical Informix database versions. 

◆	 The Informix ownerId and groupId and Informix home must be identical on the 
source and destination clients. 

The redirected restore is a 6 part process: 

1. Configuring the NetBackup server. 

2. Configuring the source client. 

3.	 Shutting down the Informix databases on both the source client and the destination 
client. 

4. Copying files from the source client to the destination client. 

5. Configuring the destination client. 

6. Performing the redirected restore. 

The following procedure explains each part of the process in detail. For more information 
on redirected restore, see the NetBackup System Administrator’s Guide. For more details on 
using Informix to back up and restore, see the Informix Backup and Restore Guide. 
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▼ To perform a redirected restore 

1.	 Configure the NetBackup server to allow redirected restores. You must be the 
NetBackup administrator to perform these tasks. 

To remove restrictions for all clients, create the following file on the Netbackup master 
server: 

install_path/netbackup/db/altnames/No.Restrictions


Or, to restrict clients to restore only from certain other clients, create the following file: 

install_path/netbackup/db/altnames/client_name


(where client_name is the name of the client allowed to perform the redirected restore). 
Add the name of the NetBackup for Informix source client to that file. 

2. Configure the NetBackup for Informix source client. 

a. Back up the logical logs on the NetBackup for Informix source client. 

A logical log contains records of all the database activity that occurs between 
backups. These records contain all the database transactions that have taken 
place after the last backup. 

Log into the source client as Informix ownerId and issue the following command: 

onbar –b -l


b. If the source client database server is down, salvage the logical logs. 

This command backs up any logical logs that have not yet been backed up and are 
not corrupted or destroyed. 

Log into the source client as Informix ownerid and issue the following command: 

onbar –l -s 


3.	 Shut down the Informix database server on both the source client and the destination 
client by issuing the following command: 

for Informix Dynamic Server 

onmode –ky


for Extended Parallel Server 

xctl onmode –ky


4.	 Copy the following files in the $INFORMIXDIR/etc directory from the NetBackup 
for Informix source client to the $INFORMIXDIR/etc directory on the NetBackup for 
Informix destination client. 
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Note	 Before overwriting the files on the destination client, back up the files in 
$INFORMIXDIR/etc directory to preserve the original configuration. 

The file copy can be accomplished by using ftp – File Transfer Protocol. 

◆ Emergency or backup boot files: 

for Informix Dynamic Server, emergency boot file 

$INFORMIXDIR/etc/ixbar.servernum 

or 

for Extended Parallel Server, backup boot file 

$INFORMIXDIR/etc/Bixbar_hostname.servernum 

where servernum is the value of the SERVERNUM configuration parameter 
specified in the $INFORMIXDIR/etc/$ONCONFIG file. 

◆	 Connectivity information file that specifies how the client application finds and 
connects to an Informix Database Server: 

$INFORMIXDIR/etc/sqlhosts


◆ Database configuration file specified by the environment variable ONCONFIG: 

$INFORMIXDIR/etc/$ONCONFIG


◆	 Files created and updated by the Informix Database server every time a dbspace, 
blobspace, logical-log file, or chunk is added or deleted. 

for Informix Dynamic Server: 

$INFORMIXDIR/etc/oncfg_servername.servernum


or 

for Extended Parallel Server 

$INFORMIXDIR/etc/oncfg_servername.servernum.coserverid  (for each 
coserver) 

where 

◆ servernum is the value of the SERVERNUM configuration 

◆ servername is the value of the DBSERVERNAME configuration 

◆ coserverid is the id of the co-server. 

◆	 XPS Server-created file that contains information about coserver location and 
dbslice definition: 

for Extended Parallel Server 
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xcfg_servername.servernum


where 


◆ servernum is the value of the SERVERNUM configuration


◆ servername is the value of the DBSERVERNAME configuration


5. Configure the NetBackup for Informix destination client. 

a.	 Set the INFXBSA_CLIENT environmental variable to the hostname of the source 
client. 

b.	 Set the INFXBSA_SERVER environmental variable to the NetBackup server used 
for the source client backup. 

Note	 The INFXBSA_SERVER needs to be changed only if the NetBackup server used for 
the source client backup is different than the server specified in the bp.conf file on 
the destination. 

6. Perform the redirected restore. 

a. Log onto the NetBackup for Informix destination client as Informix ownerId. 

b.	 Perform a physical restore (restores storage spaces to their most recent backed-up 
state): 

onbar –r –p


c.	 Perform a logical restore (updates the most recent backed-up version of the 
storage spaces with later transactions): 

onbar –r –l


Redirected Restore Example 

This example shows the procedure for restoring an Informix database from the original 
source machine, camel, to the destination machine, giraffe. For this example, the 
redirected restore is necessary because the original machine, camel, has failed. You may 
also use a redirected restore to duplicate your Informix database in a development or test 
environment. 

This example assumes the following: 

◆ Source client camel is a Solaris HP11.00 32-bit running Informix IDS 9.21. 

◆ SERVERNUM is 6 
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◆ DBSERVERNAME is srcdb 

◆ Hostname is srcclient 

◆ Destination client giraffe is a Solaris HP11.00 32-bit running Informix IDS 9.21 HC3. 

◆ SERVERNUM is 0 

◆ DBSERVERNAME is destdb 

◆ Hostname is destclient 

◆ NetBackup master server is lion. 

◆ The bp.conf on camel should include SEVER=lion, or 

◆ The env variable INFXBSA_SERVER on camel should be set to lion: 

export INFXBSA_SERVER=lion


◆ You have performed the onbar -b Informix database backup on camel. 

◆	 You have performed a file system backup of $INFORMIXDIR/etc on camel, 
effectively backing up: 

◆ ixbar.6 

◆ sqlhosts 

◆ onconfig 

◆ oncfg_srcdb.6 

◆	 You have salvaged the logical logs on camel: 

onbar -l -s 

▼ To redirect a restore from camel to giraffe (example) 

1.	 As the NetBackup administrator, create the following file on the NetBackup server, 
lion: 

install_path/netbackup/db/altnames/giraffe


2. Add the name camel to the file. 

3.	 Log into giraffe as Informix ownerId and ensure that the Informix Database Server is 
shut down. 

4.	 Perform a manual file system backup of $INFORMIXDIR/etc on giraffe, including the 
following files: 

ixbar.0


sqlhosts
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onconfig


oncfg_destdb.0


Note	 Step 4 is a precaution, in case these configuration files are needed to recreate the 
environment on giraffe. This backup will not be used for the redirected restore. 

5.	 On giraffe, change the Informix server env variable to match the variable on camel, as 
follows: 

export INFORMIXSERVER=srcdb


6.	 On giraffe, change the INFXBSA_CLIENT env variable to camel, as follows: 

export INFXBSA_CLIENT=camel 

This allows giraffe to browse backups from camel. 

7.	 On giraffe, set the INFXBSA_SERVER env variable to lion, as follows: 

export INFXBSA_SERVER=lion 

Note	 Step 7 is necessary only if the server specified in the bp.conf file on giraffe is not 
lion. 

8.	 Browse the file system backups from camel, and restore the following files to 
$INFORMIXDIR/etc on giraffe. 

ixbar.6 

sqlhosts 

onconfig 

oncfg_destdb.6 

9. Perform the redirected restore to giraffe: 

a.	 Perform the physical restore: 

onbar -r -p 

b.	 Verify the return status using the following command: 

echo $? 

If the restore was successful, the return status will be 0. 

c. Perform the logical restore: 
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onbar -r -l


d.	 Verify the return status using the following command: 

echo $? 

If the restore was successful, the return status will be 0. 
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Troubleshooting 
5


This chapter explains how to determine and resolve problems encountered when using 
NetBackup for Informix. It contains the following sections: 

◆ Troubleshooting Tips 

◆ NetBackup Logs 

◆ Setting the Debug Level 

◆ Preventing Timeout Failures on Large Database Restores 

◆ Deleting Expired Backups from the Informix Backup Database 
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Troubleshooting Tips 
Refer to this section when troubleshooting NetBackup for Informix. 

◆ Refer to Informix Backup and Restore Guide, available on-line at www.informix.com. 

◆	 For the IBM AIX platform, Informix 7.3 requires the file infxbsa.so instead of 
infxbsa.a. For Informix 7.2, infxbsa.a will be used. The ar command can be 
used to extract infxbsa.so from infxbsa.a if necessary. 

◆	 Verify the existence of $BAR_BSALIB_PATH, which is defined in the Informix 
$CONFIG file. This should point to NetBackup's infxbsa.[so,sl,a]. The 
permission should be 755. 

◆	 Verify that the Informix policy and schedule are properly created. Refer to 
“Configuring a NetBackup Policy” on page 25. 

◆ Set BAR_DEBUG: Set 

◆	 Set the following variables in the Informix configuration file 
($INFORMIXDIR/etc/$ONCONFIG): 

◆ BAR_DEBUG 

◆ BAR_DEBUG_LOG 

BAR_DEBUG sets the level of detail that will be gathered about the backup. Range is 
0-9, with 9 providing the most detail. 

BAR_DEBUG_LOG sets the location of the file that will collect the log. This should be 
the same location specified by MSGPATH in the Informix configuration file 
($ONCONFIG). 

To set these variables, stop / restart the Informix instance. In Informix version 7.X and 
9.X engines, run the following Informix commands: 

onmode -uky

oninit


In Informix version 8.X engines, run the following commands: 

xctl onmode -uky

xctl -C oninit


◆ Check the Informix instance log pointed to by the MSGPATH onconfig variable. 

◆	 Make sure the table bar_version in the sysutils database has the correct value for 
the bar_version column. It should be 1.1.1 for Informix 7.3 or later. 

◆ Verify the existence of the following directories. Their permissions should be 777. 

install_path/netbackup/ext/db_ext/informix/infx_db_comm

install_path/netbackup/logs/infxbsa
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◆ Examine the following client logs in the following order: 

1. Informix server log, path is specified in ONCONFIG. 

2. OnBAR debug log, path is specified in ONCONFIG. 

3. install_path/netbackup/logs/infxbsa. 

If this directory was created properly and no log was present, then STOP. Do not 
go any further since this is the starting point of communication with NetBackup 
and there are no further NetBackup activities on either the server or client. Do the 
following: 

a. Examine the OnBAR debug log to determine the cause. 

b. Verify the table bar_version in the sysutils database. 
The column bar_version should have the value 1.1.1 for Informix 7.3. 

bar_version


1.1.1 


c. Make sure $BAR_BSALIB_PATH is linked to 
NetBackup's infxbsa.[so,sl,a] correctly. 

4. install_path/netbackup/logs/bpbackup or bprestore 

A backup/restore request from OnBAR will result in a call to 
bpbackup/bprestore. Check for any error from this log. This log will show if a 
backup/restore request was successfully sent to NetBackup's main request 
daemon. 

◆	 Look for error code in install_path/netbackup/logs/infxbsa, then 
depending the type of error found, refer to the log in the following server directory, if 
it exists. 

install_path/netbackup/logs/bprd


This log shows if a backup/restore request from bpbackup/bprestore was 
received. Examine the request's details such as client name, policy type, client type, 
and backup file name. 

When the following directories are created on the client, a file is created for each 
backup/restore session. These files have the naming convention of log.mmddyy. 

install_path/netbackup/logs/bpdbm

install_path/netbackup/logs/bpcd

install_path/netbackup/logs/bpbrm

install_path/netbackup/logs/bptm

install_path/netbackup/logs/bpsched

install_path/netbackup/ext/db_ext/informix/infx_db_comm
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These files may offer additional debug information. The name of the file can be found 
in the install_path/netbackup/logs/infxbsa directory. Search for the 
backup/restore request in this log. For example: 

11:18:39 [671] <4> BSACreateObject: INF - Issue backup command:

install_path/netbackup/bin/bpbackup -I 

-L install_path/netbackup/ext/db_ext/informix/infx_db_comm/infxbsa.671.0 

-t 6 /legohead/rootdbs/0


The above message was generated by an OnBAR request for a backup session. The 
temporary file used was: 

install_path/netbackup/ext/db_ext/informix/infx_db_comm/infxbsa.671.0
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NetBackup Logs 
The NetBackup server and client software allow you to set up detailed debug logs for 
troubleshooting problems that occur outside of either NetBackup for Informix or the 
Informix On-BAR Utility. See the NetBackup Troubleshooting Guide for UNIX and Windows 
for a complete description of debug logs. Also see the 
install_path/netbackup/logs/README.debug file. 

Note	 These logs do not reveal errors that occur during the execution of the Informix 
On-BAR Utility, unless those errors also affect NetBackup for Informix. Informix 
may (or may not) use the NetBackup for Informix logs for errors in the application. 
Your best sources for Informix error information are the logs provided by Informix. 

Note In general, each debug log corresponds to a NetBackup process and executable. 

▼ To enable the NetBackup for Informix logs 

1. Create the following directories on the client: 

install_path/netbackup/logs/bphdb

install_path/netbackup/logs/infxbsa


% cd install_path/netbackup/logs/

% mkdir bphdb

% mkdir infxbsa


2. Set the access permissions to 777 on these log directories. 

% chmod 777 bphdb 

% chmod 777 infxbsa


The following sections describe the logs created when you create the log directories. Use a 
text editor to view the contents of the logs. 

bphdb Directory on the Client 

The install_path/netbackup/logs/bphdb directory contains the following types 
of logs. These logs are a good starting place to determine what type of error occurred. 

onbar_stdout.mmddyy 

Unless redirected elsewhere, NetBackup places On-BAR script output in this 
file. 

onbar_stderr.mmddyy 
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Unless redirected elsewhere, NetBackup places On-BAR script errors in this 
file. 

log.mmddyy 

bphdb is the NetBackup Database Backup binary. This log contains 
debugging information for the bphdb process. NetBackup for Informix uses 
this client process for On-BAR script execution. It is invoked when an 
automatic backup schedule is executed. 

infxbsa Directory on the Client 

The install_path/netbackup/logs/infxbsa directory contains the following 
execution log. 

log.mmddyy 

This log contains debugging information and execution status for the 
Informix NetBackup client processes linked to the library program provided 
with NetBackup for Informix. 

install_path/netbackup/logs/


NetBackup Server Reports 

NetBackup provides other reports that are useful in isolating problems. One such report is 
All Logs Entries on the server. See the NetBackup System Administrator’s Guide for Windows, 
Volume I or NetBackup System Administrator’s Guide for UNIX, Volume I for a description of 
this and other reports. 

Informix On-BAR Utility Logs 

The Informix On-BAR Utility performs its own error logging and tracing in the file 
specified by BAR_ACT_LOG in the $INFORMIXDIR/etc/ONCONFIG file. Database 
administrators can use this log file to determine what has happened during On-BAR 
execution. 
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Setting the Debug Level 
You can control the amount of information written to the debug log in the 
install_path/netbackup/logs/ directories by changing the Database debug level. 
The higher the value, the more information is logged. In everyday normal operations, the 
default value of 0 is sufficient. However, VERITAS Technical Support may ask you to set 
the value higher when a problem is being analyzed. 5 is the highest possible setting. 

❖	 To change the Debug Level, enter the following line in the bp.conf file. 

VERBOSE = 5 

Preventing Timeout Failures on Large Database Restores 
Large database restores sometimes fail when multiple restore sessions compete for 
resources. In this situation, a restore session can be delayed waiting for media or device 
access. If the delay is too long, the restore session times out. 

This problem can be resolved by increasing the Client Read Timeout property, which 
prevents session timeouts and allows the restores to complete successfully. 

Use the NetBackup Administration Console on the server to change the properties of each 
client that contains a database you may need to restore. The Client Read Timeout 
property is found on the Timeouts host properties dialog of the master and media servers. 
The default for the Client Read Timeout setting is 300 seconds (5 minutes). For database 
agent clients, increase the value significantly to prevent timeout errors, e.g. 30 minutes. 

Deleting Expired Backups from the Informix Backup  
Database 

Informix Versions XPS 8.x and IDS 9.x 

onsmsync is an Informix version XPS 8.x, IDS 9.x utility that synchronizes the NetBackup 
catalog with the Informix backup catalog. Use the onsmsync utility to delete images from 
both Informix backup catalogs and NetBackup catalogs. Refer to the Informix Server 
Administration Guide for more information on how to use this utility. 
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Informix Version IDS 7.x 

Informix version IDS 7.x does not have a mechanism for deleting records of expired 
backups from its backup database. NetBackup for Informix provides a script that will 
delete these records from the Informix backup database if the NetBackup image database 
has expired the backups. To run the script, execute the following command as user 
informix or the Informix Administrator. 

install_path/netbackup/ext/db_ext/informix/scripts/infx_remove_expired_images


When this script runs, it creates files in the /tmp directory. These files are not removed so 
that they can be used to diagnose any problems that occur. 
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